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COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COMBINED OPTIMIZATION AND PERFORMANCE ANALYSIS MODEL – Teaching Unit 1 
TU1.1:          INTRODUCTION 

 

 
 
 
 
 
 
In order to facilitate the calculation and the analysis of large networks, a computer software called 
COPAM - Combined Optimization and Performance Analysis Model, has been developed by 
Lamaddalena (1998).  

 

 
All computer programs developed for the computation and the analysis of irrigation systems require 
detailed information on the pipes network transporting water from the source to the demand points 
(hydrants).  
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COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 1 
TU1.1:          INTRODUCTION            

 
 
 
 
 
 

This software has several options. Some of them will be explained throughout the course. Please 
find COPAM enclosed in the directory**********.  
 

In the following, general information on the installation of the program and the preparation of the 
input data files are referred as well as the use of some options of COPAM.
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
  MODULE 3: COPAM – Teaching Unit 1  
  TU1.2:          INSTALLATION AND STARTING 

Basic Windows knowledge is required for installing the COPAM Package. 
1. Create an appropriate directory in the hard disk (you can call it “Copam”), 
2. Insert the install disk in the appropriate drive, 
3. Copy all files from the install disk to the directory previously created (Copam). Verify that also 

the files “*.dll” have been copied, 
4. From explorer program, open the directory Copam and create a shortcut on the desktop for the 

file (icon) “copam.exe”, 
5. Change the name occurring below the icon by clicking one time on its label. It is suggested to 

call it COPAM, 
6. Double click on the COPAM icon. Figure 8 will appear for few seconds followed by figure 9. 

Three different sets of programs are available in the COPAM package.  
1) Discharges computation   
2) Pipe size computation  
3) Analysis 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
  MODULE 3: COPAM – Teaching Unit 1 
  TU1.2:          INSTALLATION AND STARTING 

Figure 8: First screen of the COPAM Package      Figure 9: Layout of the COPAM package 

 

Two programs are available under the set “ Discharges computation”: Clément and Random. One 
program is available under the set “Pipe size computation”: optimization. Two programs are available 
under the set “Analyses”: Configurations and Hydrants.  
For all the above softwares, the basic input file is the same and it will be explained below.
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 1 
TU1.2:          INSTALLATION AND STARTING 

 

When clicking with your mouse on any of the menu bar words, a sub-menu will drop down. Different 
options are available in the File menu: New, Open, Save, Save as, Print input file, Setup printer, 
View file, Exit. All these options are familiar for windows users. To create a new file, the option “New” 
has to be clicked and after, the menu bar “Edit” has to be selected. The sub-menu in Figure 10 will 
drop down. 

By clicking on each of the available options, the input data may be insert in the Edit menu. It is 
strongly recommended to prepare the input data before entering in the program. 

Figure 10: Edit menu bar and its sub menu items 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 

  TU2:             INPUT FILE PREPARATION 
 

It is suggested to select first the sub-menu “Edit/Hydrants Discharge” by clicking on it. The Figure 11 
will appear and the list of the nominal discharges of the hydrants has to be inserted in the 
appropriate edit box. The list of hydrants discharge has to be introduced in an increasing order. 
The command “OK” will close the option and store the information. 
 

Figure 11 : Sub menu Edit/Hydrants discharge 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 

  TU2:             INPUT FILE PREPARATION 
 

By clicking on the option “Network layout”, the input data may be inserted in the sub-menu 
“Edit/network layout”.  
It is assumed that the network is of the branching type. Each node (hydrants and/or linking of 
sections) is positioned by a number. The node numbering is extremely important for the correct 
execution of the program. It has to be allocated as follows: 
 
- the upstream node (source) must have number 0, 
- the other nodes have to be numbered consecutively, from upstream to downstream. Any node may 

not be jumped,  
- The number of the section is equal to the number of its downstream node, 
- All terminal nodes of the branches must have a hydrant 
- No more than two sections may be derived by an upstream node. If so, an imaginary section with 

minimum length (i.e.: lmin = 1 m) must be created and an additional node must be considered. This 
node must have a sequential number. 

- No hydrants may be located in a node with three sections join. If so, an additional node with a 
sequential number must be added. 

- If hydrants with two or more outlets exist in the network, one number for each outlet needs to be 
allocated by creating an imaginary section with minimum length. (Figure. 12). 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 

  TU2:             INPUT FILE PREPARATION 
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Figure 12: Examples of nodes numbering 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 

  TU2:             INPUT FILE PREPARATION 
 

When the numbering has been completed, the following information has to be filled in the 
“Edit/Network layout”: 
 

- Area irrigated by each hydrant (in hectares). If no hydrant occurs in the node, Area=0 has to be typed; 
- Hydrant discharge (in l s-1). It may be selected by clicking in the combo box; 
- Section length (in m), 
- Land elevation of the downstream node (in m a.s.l.), 
- Nominal diameter of the section pipe (in mm). This information has to be included when the program is 

used for the analysis. In the design stage, Diameter=0 must be considered. 

In Figure 13, an example of the sub-menu “Edit/network layout” is reported. 

 

 

 

 

 

 

 

 

Figure 13: Edit/network layout sub menu 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 

  TU2:             INPUT FILE PREPARATION 
 

Additional options are available on the bottom of the screen. They may be activated by clicking on 
the button: Add Node, Canc Node, Ins Node and Find Section, respectively for adding a new 
node, deleting a node, inserting a node and finding a node. The exit button will close the sub menu. 
 

When the network layout is completed, the “Edit/list of pipes” sub menu has to be selected. Figure 14 
will appear: 

 
Figure 14: Edit list of pipes sub menu 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 
TU2:             INPUT FILE PREPARATION 

 

The list of commercial diameters (in mm) has to be inserted in the “Edit/list of pipes” sub-menu. The 
list has to be completed by: the thickness (in mm) of the pipes; the roughness (Bazin coefficient) and 
the unitary cost of the pipe.  

An internal procedure of the COPAM package will link, automatically, the currency to the regional 
setting properties of your computer. The pipes unitary costs must be typed in increasing order.  

The nominal diameters have to be typed in the grid. When the nominal diameter corresponds to the 
internal diameter, the pipe thickness has to be considered equal to zero. The types of pipes are 
identified by the Bazin roughness coefficient.  

In the sub-menu “Edit/Description” (Figure. 15), the description of the file may be typed. This 
information is important when a large number of data files have to be managed and recognized after 
time.  

Figure 15: Edit description sub menu 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 2 
TU2:             INPUT FILE PREPARATION RATION 

 

An additional option is available in the COPAM package: the toolbar button “Check input file”. 

It allows to control the most common errors in the input file (Figure. 16). 

 
    Figure 16: Toolbar button “Check input file” 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS 
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 
TU3.1:          INTRODUCTION 

 

 
 
 
 
 
 
When the set “Discharge computation” is selected, two different programs are available:  
“Clément” for OFRM and “Random” for SFRM. 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 
TU3.2:          OFRM – FIRST FORMULA OF CLEMENT 

 

“Clément” allows for the computation of the discharges flowing into the network through the first and 
the second Clément models.   
 
 
When the first formula is selected, the following additional parameters have to be typed in the  
“Clément parameters/sub-menu”:  
 

- specific continuous discharge (in l s-1 ha-1) 
- minimum number of terminal open hydrants 
- percentage of uncultivated land (in %) 
- Clément use coefficient (r) 
- Clément operation quality, U(Pq)  
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 
TU3.2:          OFRM – FIRST FORMULA OF CLEMENT 

 

The name of the output file has to be typed in the appropriate edit box. It will be automatically assigned the 
extension “.cle” (Figure 17). An example of the output file of the program “Clément” is reported in Table 2. 
 

 
 
 
 
 

Section Initial Final  Number of  Area  1st Clément 
Number   Node    Node  Hydrants   (ha)  discharge (l/s)  
******************************************************** 
   1      0       1       19     57.00    60.00 
   2      1       2       18     54.00    60.00 
   3      2       3       17     51.00    50.00 
   4      3       4       16     48.00    50.00 
   5      4       5       15     45.00    50.00 
   6      5       6       14     42.00    50.00 
   7      6       7       11     33.00    40.00 
   8      7       8        8     24.00    40.00 
   9      8       9        7     21.00    40.00 
  10      9      10        6     18.00    40.00 
  11     10      11        5     15.00    40.00 
  12     11      12        5     15.00    40.00 
  13     12      13        4     12.00    40.00 
  14     13      14        3      9.00    30.00 
  15     14      15        2      6.00    20.00 
  16     15      16        1      3.00    10.00 
  17      7      17        3      9.00    30.00 
  18     17      18        3      9.00    30.00 
  19     18      19        2      6.00    20.00 
  20     19      20        1      3.00    10.00 
  21      6      21        3      9.00    30.00 
  22     21      22        2      6.00    20.00 
  23     22      23        1      3.00    10.00 
  24      8      24        1      3.00    10.00 

Table 2 – Discharges flowing into each section of the network under 
study (output of the COPAM package: computation with the first Clément 
model) 
 

Figure 17:  Clément parameters: 1st Clément formula 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 
TU3.3:          SFRM – RANDOM GENERATION MODEL 

 

The program for the random generation of discharge configurations (RGM: Random Generation Model) 
is integrated in the COPAM package. It may be selected by clicking on the appropriate button 
(Figure.18): 

Figure 18:  Random Generation Program 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 
TU3.3:          SFRM – RANDOM GENERATION MODEL  

 

Figure 19 will occur on the screen. 
The input data concerning the irrigation network, are those illustrated in the previous section. 

  

Figure 19:  Random Generation Parameters 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 3: DISCHARGES COMPUTATION 

  TU3.3:          SFRM – RANDOM GENERATION MODEL 
 

 

The RG Model may be used for two different purposes:  
- design of new irrigation systems; 
- analysis of existing irrigation systems. 
 
In the first case, COPAM package (Clément formula) can be used as explained in the previous section 
for computing the upstream discharge. In the second, this model is based on the knowledge of the 
demand hydrograph at the upstream end of the network.  
The discharge value will be allocated in the edit box “Upstream discharge” of the “Random generation 
parameters”. After including, in the appropriate edit box, the number of configurations to be generated 
(it must be multiple of 10), the operation of the network may be simulated by generating the hydrants 
configurations (fig. 15). 
These hydrants configurations, stored in a pre-selected output file, may be taken into account for 
computing the optimal pipe size of the network.  
All the generated flow regimes will be stored in an output file; its name has to be typed in the 
appropriate edit box. Extension “.ran” will be automatically assigned to this output file. 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.1:          CONFIGURATIONS ANALYSIS - INDEXED CHARACTERISTIC CURVES 
 

A software package generating the indexed characteristic curves is available at the CEMAGREF 
(France, 1990) and it may be coupled with the software XERXES-RENFORS (CEMAGREF, 1990).An 
alternative software for computing the indexed characteristic curves has been written and integrated in 
the COPAM package. By clicking on the button program “Configuration” the Figure 20 will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 20: Characteristic curves program: Parameters of the analysis 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.1:          CONFIGURATIONS ANALYSIS - INDEXED CHARACTERISTIC CURVES 
 
 
 
 
The name of the output file as well as the one of the file in which the random generated flow regimes 
will be stored has to be written in the appropriate edit box. 
 
Extensions “.ica” and “.ran” will be respectively automatically assigned.  
 
The piezometric elevation (m a.s.l.) available at the upstream end of the network, and the design 
upstream discharge (l s-1) have to written in the “set point data” option.  
 
The list of discharges to be tested, flowing at the upstream end of the network, has to be inserted in 
the appropriate box, as well as the number of regimes to generate for each discharge. 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.1:          CONFIGURATIONS ANALYSIS - INDEXED CHARACTERISTIC CURVES 
 

The program allows computations for networks where the minimum pressure head Hmin required for 
an appropriate on-farm irrigation is constant or variable.  
 

In the first case the radio button “Constant” has to be selected in the frame “Minimum head at the 
hydrants” and the value Hmin has to be written in the appropriate box.  
 

In the second case, the radio button “Variable” has to be selected and the values of the minimum 
head at each hydrant have to be inserted in the last column of the input file (Figure 21). 

Figure 21:  Input file: Edit network layout 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.1:          CONFIGURATIONS ANALYSIS - INDEXED CHARACTERISTIC CURVES  
 

COPAM has a very easy graphical interface.  
 
It allows to print the characteristic curves of the network by clicking on the “Graph” menu bar and 
successively on the “Characteristic curves …” Sub-menu item (Figure 22).  
 
The name of the output file (extension “.ica”) has to be selected for printing the graphic (Figure 23). 

Open file  

File name 

 

File  

 

Figure 22: Graph menu bar and sub-menu items Figure 23: Open file to print the characteristic curves 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA 
 

A computer software for the computation of the percentage of unsatisfied hydrants and the relative 
pressure deficits, has been integrated in the COPAM package (Figure 24). By clicking on the button 
program “AKLA” (Figure 24), the Figure 25 will appear. 
 

Figure 24: Hydrants analysis program: AKLA model Figure 25: Hydrants analysis program: “Options” Tab 
control, “Several-random generation” flow regime 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA 
 

Within the “Options” Tab control, two alternative types of flow regimes are available (Figure 25):  
 the first allows to generate automatically the random flow regimes 
 the second allows to read the flow regimes from an external file. This second option allows the 

analysis also for irrigation systems operating on rotation and/or on arranged demand. In these 
cases, in fact, the flow regimes may be previously generated according to the management 
rules and stored in an appropriate file to be read by the program (Figure 26). 

Figure 26: Hydrants analysis program: “Options” Tab control, “Several-
read from file” flow regime 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA  
 

 

 

The name of the output files in which storing information on the hydrants relative pressure deficit, 
on the percentage of unsatisfied hydrants, as well as the name of the file in which the random 
generated flow regimes have to be stored, have to be written in the appropriate edit boxes.  
Extensions “.hyd”,  “.puh” and “.reg” are respectively, automatically assigned. 
 
In case the option “Several – random generation” is selected, the number of regimes to generate for 
each discharge has also to be typed in the appropriate edit box (Figure 25).  
 
In case the option “Several - read from file” is selected, the name of the file in which flow regimes 
have been previously generated and stored has to be written in the box “Read regimes from file …” 
(Figure 26). In this case the number of flow regimes to be generated is not required because the flow 
regimes are already stored in the file. 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA  
 

AKLA allows the computations for networks where Hmin required is constant or variable.  
 

In the first case the radio button “Constant” has to be selected in the frame “Minimum head at the 
hydrants” and the value of  Hmin has to be written in the appropriate box.  
In the second case, the option “Variable” has to be selected and the values of Hmin at each hydrant 
have to be typed in the last column of the input file (Figure 21). 
 

The upstream piezometric elevation (m a.s.l) available and the design upstream discharge (l s-1) 
have to typed in the “set point” tab control (Figure 27).  

 Figure 27: Hydrants analysis program: “Set point” Tab control 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA  
 

The lists of the upstream discharges and piezometric elevations of the network to be tested, have to 
be inserted in the appropriate boxes under the “Elevation-Discharge” Tab control (Figure 28).  
These values allow the computation of the percentage of unsatisfied hydrants when the upstream 
discharges and piezometric elevations vary.  

It is important to include the set point data among these values. In fact, the relative pressure 
deficits are computed only for the set point values. 

Figure 28: Hydrant analysis program: “Elevation-discharge” Tab control 
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  COURSE WM – ON DEMAND PRESSURIZED IRRIGATION SYSTEMS  
MODULE 3: COPAM – Teaching Unit 4: ANALYSIS 

  TU4.2:          HYDRANTS ANALYSIS - AKLA  
 

The graphical interface of the COPAM package allows to print easily all the information obtained by 
the AKLA model. By clicking on the “Graph” menu bar it is possible to select the available sub-menu 
items: hydrants deficit, hydrants deficit (envelope curves), PUH curves (one elevation), PUH curves 
(all elevations) (Figure 29). 
The graphical interface allows to print also the hydrants reliability. 
For printing the hydrants deficit and the hydrants reliability, the output file “.hyd” has to be selected, 
while for printing the PUH curves, the output file “.puh” has to be selected. 

Figure 29: “Graph” menu bar and sub-menu items 
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SUMMARY 
 

 
Large pressurised irrigation systems allow for better services and higher distribution efficiency.   

On demand irrigation systems offer the greatest opportunity to match irrigation demands.  
 

The main objective of this course is the development of the basic skills for the use of a 
computer tool that permits the design and the analysis of performance of pressurized irrigation 
systems functioning on demand.  
 

The first formula of Clément and the Random Generation Model are used to compute the 
design flow, through a user friendly computer package called COPAM.  
 
The crucial outputs of this study are the following: 
 

1. “Discharges computation”: Clément and Random 
2. “Pipe size computation “: optimisation  
3. “Analyses” Configurations and Hydrants 

 
Finally COPAM facilitates the optimal design and the performance analysis of large scale irrigation 

systems. 
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GLOSSARY 
 

 

 
 

Title Abstract NOTE 

Branching type 

 
There are two types of distribution systems: 
Branched systems have only one path to follow 
from the source to the customer. Think of the 
system as one-way flow. 
Looped systems have pipes that are 
interconnected throughout such that water can 
move through the entire system back and forth 
depending on the points of largest demand. 

 

 

Looped Branched 
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Nominal diameter of 
the section pipe (in 

mm) 

A pipe's nominal diameter refers to its common 
name, such as a (400-mm) pipe. 
The pipe's internal diameter (ID)refers to the distance 
from one inner wall of the pipe to the opposite wall. 
ID may differ from the nominal diameter because of 
manufacturing standards. The ID may change over 
time as corrosion, tuberculation, and scaling occur 
within the pipe. Corrosion and tuberculation are 
related in iron pipes. As corrosion reactions occur on 
the inner surface of the pipe, the reaction by-
products expand to form an uneven pattern of lumps 
(or tubercules) in a process called tuberculation. 
Scaling is a chemical deposition process that forms a 
material build-up along the pipe walls due to 
chemical conditions in the water. For example, lime 
scaling is caused by the precipitation of calcium 
carbonate. Scaling can actually be used to control 
corrosion, but when it occurs in an uncontrolled 
manner it can significantly reduce the ID of the pipe. 
Of course, no one is going to refer to a pipe as a 
426.72-mm pipe, and because of the process just 
described, it is difficult to measure a pipe's actual 
internal diameter. As a result, a pipe's nominal 
diameter is commonly used in modeling, in 
combination with a roughness value that accounts for 
the diameter discrepancy. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

441.96 mm
OD 

 

7.62 mm
Th  426.72 

mm 
ID  

Cross section of a pipe: 
internal diameter, 

thickness and outside 
diameter 
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Standard normal 
variable 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

For a population of R homogeneous hydrants, the 
probability of finding one hydrant open is p, while (1 - p) is 
the probability to find it closed.  
The number of operating hydrants is then considered as a 
random variable having a binomial distribution law with 
mean = R p and  variance 2 = R p (1-p). 
Therefore, the cumulative probability, Pq, that among the R 
hydrants there will be a maximum of N hydrants 
simultaneously operating is 
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is the number of combinations of R hydrants taken K at a 
time. 
When R is sufficiently large (R > 10) and p > 0.2-0.3, the 
binomial distribution approximates the Laplace-Gauss 
normal distribution whose cumulative probability (Pq) for 
having a maximum of x hydrants simultaneously operating 
(with -  < x < N) is: 
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where U(Pq) is the standard normal variable corresponding 
to the probability Pq, and u  is the standard normal deviate 
given by 
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The integral is solved developing in series the exponential 

function e
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. The solutions of this integral have been 
tabulated (see Table) and so, according to a prefixed value 
Pq, it is possible to determine the corresponding value 

 
 
 
 
 
 
 

Standard normal cumulative 
distribution function 

 
 

Pq U(Pq) 
0.90 1.285 
0.91 1.345 
0.92 1.405 
0.93 1.475 
0.94 1.555 
0.95 1.645 
0.96 1.755 
0.97 1.885 
0.98 2.055 
0.99 2.324 
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U(P q ). 
Knowing U(Pq ), it is possible to calculate the number of 
hydrants simultaneously operating, N 

p)-(1 pR)qU(PpRN   (first formula of Clément). 

Considering hydrants with the same discharge, the total 
discharge downstream a generic section k is given by: 

2d)p1(pR)qU(PdpR =kQ   

 and, when different classes, i, of hydrants discharges,di, 
are considered 

2
id)ip1(ipiRi)qU(PidipiR i=kQ   

Use coefficient 

Assuming that T is the duration of the peak period (h) and 
T' is the operating time of the network (h) during the period 
T, r is defined as the ratio T'/T. It is defined by Clément as 
coefficient of utilization of the system in the sense that, 
during the design phase, the duration of the day for 
irrigation, within the peak period, is considered shorter than 
24 hours. This parameter, defined at the network level in 
an irrigation system operating on-demand, should have a 
value equal to one because these systems may have to 
work 24 hours per day. 
In practice, the parameter r corresponds to the operating  
time of each hydrant and, it is not correct to use it for the 
global design of the system. 

 

 

 


